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Overview 

Stellar Migrator for MS Exchange enables you to migrate mailboxes from one MS Exchange server to 

other. The software exports mailboxes from Donor Exchange server to PST files that can be imported in 

MS Outlook. Additionally, you can also preview mailbox items including Emails, Contacts, Calendar, 

Notes, Tasks, Attachments etc. 

The server from where you need to migrate the mailboxes into another is known as Donor Exchange and 

the intended destination server to where all these mailboxes are migrated is known as Recipient 

Exchange. The configurations are handled on the Local System as well as on Donor Exchange server. To 

migrate mailboxes, you need an Impersonate User on the Donor Exchange along with the Impersonate 

Profile of donor and an Administrator Profile of Recipient Exchange configured on your local system and 

Donor Exchange server. 

Key Features 

 Supports migration of complete mailboxes. 

 Export user mailboxes to PST on local system. 

 Export user mailboxes to Recipient Exchange. 

 Save selective mailboxes to PST files. 

 Supports automap feature using mailbox names and E-mail Id's. 

 Save individual mail items in MSG, EML, HTML, RTF, PDF formats. 

 Option to preview mailbox data including Emails, Contacts, Calendar, Notes, Tasks, Attachments, 

etc. 

 Supports MS Outlook 2013 / 2010. 

 Supports MS Exchange Server 2013 / 2010. 

 Supports Windows 10 / Windows 8.1 / Windows 8 / Windows 7 / Windows Server 2008 / Windows 

Server 2012. 
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Installation Procedure 

Before installing the software, check that your system meets the minimum system requirements: 

Minimum System Requirements: 

 Processor: Pentium Class 

 Operating System: Windows 10 / Windows 8.1 / Windows 8 / Windows 7 / Windows Server 2008 / 

Windows Server 2012 

 Memory: Minimum 1 GB 

 Hard Disk: 50 MB of Free Space 

 MS Outlook: 2013, 2010 

Note:   

 To export your Contacts and Tasks, Exchange Server 2010 (Service Pack 3 and above) must 

be installed. 

 .NET Framework 4.0 and above must be installed. 

  

To install the software, follow these steps: 

 Double-click StellarMigratorforMSExchange.exe executable file to start installation. Setup- 

Stellar Migrator for MS Exchange dialog box is displayed. 

 Click Next. License Agreement dialog box is displayed. 

 Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

 Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

 Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog 

box is displayed. 

 Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 
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 Review the entries. Click Back if you want to change them. Click Install to start installation. The 

Installing window shows the installation process. 

 After completing the process, Completing the Stellar Migrator for MS Exchange Setup Wizard 

window is displayed. Click Finish. 

Note: Clear Launch Stellar Migrator for MS Exchange check box before clicking Finish to prevent the 

software from launching. 
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Launching the Software 

To launch Stellar Migrator for MS Exchange in Windows 10: 

 Click Start icon -> All apps -> Stellar Migrator for MS Exchange -> Stellar Migrator for MS 

Exchange . Or, 

 Double click Stellar Migrator for MS Exchange icon on the desktop. Or, 

 Click Stellar Migrator for MS Exchange tile on the home screen. 

 

To launch Stellar Migrator for MS Exchange in Windows 8.1 / 8: 

 Click Stellar Migrator for MS Exchange tile on the home screen. Or, 

 Double click Stellar Migrator for MS Exchange icon on the desktop. 

 

To launch Stellar Migrator for MS Exchange in Windows 7: 

 Click Start -> Programs -> Stellar Migrator for MS Exchange  -> Stellar Migrator for MS 

Exchange . Or, 

 Double click Stellar Migrator for MS Exchange icon on the desktop. Or, 

 Click Stellar Migrator for MS Exchange icon in Quick Launch. 
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User Interface 

Stellar Migrator for MS Exchange software has a very easy to use Graphical User Interface. 

After launching the software you will see the main user interface as shown below: 

 

The user interface contains Menus and Buttons that allows you to access various features of the software 

with ease. 
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Menus 

Setup Menu 

 

 

 

Select Donor 

Use this option to enter the details of MS 

Exchange server from where you want to export 

mailboxes. 

Select Recipient 

Use this option to export mailboxes either in PST 

format or to the Recipient server. 

Update Wizard 

Use this option to check for both, latest minor 

and major versions available online. 

 

Logs Menu 

 

 

 

Log Report 

Use this option to view / save the log report. 

 

 

 

Registration Menu 

 

 

 

Registration 

Use this option to register the software after 

purchasing. 
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Help Menu 

 

 

 

Help 

Use this option to view the help manual for the 

software. 

Order 

Use this option to buy Stellar Migrator for MS 

Exchange software. 

Support 

Use this option to view the support page of 

stellarinfo.com 

Knowledgebase 

Use this option to visit Knowledgebase articles of 

stellarinfo.com 

Enquiry 

Use this option to submit enquiry to 

stellarinfo.com 

About 

Use this option to read information about the 

software. 

 

Style Menu 

 

http://www.stellarinfo.com/email-tools/migrator-for-exchange/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/
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Use this option to switch between various themes 
for the software, as per your choice. 
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Buttons 

 

 

Click this button to enter the details of donor exchange server.  

 

 

 

 

Click this button to export mailboxes either in PST format or to the Recipient server. 

 

 

 

 

Click this button to check for both, latest minor and major versions available online. 

 

 

 

Click this button to view / save the log report. 

 

 

 

Click this button to register the software after purchasing. 

 

 

 

Click this button to view the help manual for the software. 

 

 

 

Click this button to buy Stellar Migrator for MS Exchange software. 

 

 

 

Click this button to view the support page of stellarinfo.com. 
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Click this button to visit Knowledgebase articles of stellarinfo.com. 

 

 

 

Click this button to submit enquiry to stellarinfo.com. 

 

 

 

Click this button to read information about the software. 
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Ordering the Software 

Click http://www.stellarinfo.com/email-tools/migrator-for-exchange.php to know more about Stellar 

Migrator for MS Exchange. 

To purchase the software online, please visit http://www.stellarinfo.com/email-tools/migrator-for-

exchange/buy-now.php 

Alternatively, click Order icon in Help Menu on Menu Bar to purchase the software online.  

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 

to activate the software. 

http://www.stellarinfo.com/email-tools/migrator-for-exchange.php
http://www.stellarinfo.com/email-tools/migrator-for-exchange/buy-now.php
http://www.stellarinfo.com/email-tools/migrator-for-exchange/buy-now.php
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Registering the Software 

You can visit http://www.stellarinfo.com/email-tools/migrator-for-exchange.php to download the demo 

version of Stellar Migrator for MS Exchange software. Once you purchase the software, you will receive 

a key using which you can register the software.  

You can register the software using any of the following methods: 

 Online Registration 

After purchasing the software, a serial number will be sent via email, which is required to register 

the software. You need to enter the serial number, which is then verified by a license server and on 

verification, the software is registered. 

 Manual Registration 

To register the software manually, you will need to generate a PHX_REG.txt file and mail it to 

support@stellarinfo.com. After verification of the serial number and purchase details, the site key, 

which is required to register the software manually, will be sent to your email address. 

Note: If the software is downloaded from http://www.stellarinfo.com/email-tools/migrator-for-

exchange.php (i.e., ESD version), it must be registered using Serial Number (received through email after 

purchasing the product) to use all the features of the software. 

If the software is installed using the product installation CD (i.e., BOX version), hardware lock ,that is 

available with the software kit, is mandatory for the functioning of the software. 

  

http://www.stellarinfo.com/email-tools/migrator-for-exchange.php
mailto:support@stellarinfo.com
http://www.stellarinfo.com/email-tools/migrator-for-exchange.php
http://www.stellarinfo.com/email-tools/migrator-for-exchange.php
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Online Registration 

To register the software online: 

 
 

 

1. Launch demo version of 

Stellar Migrator for MS 

Exchange. 

2. In Registration Menu on 

Menu Bar, Click 

Registration.  

3. In Registration Option 

dialog box, select I have 

the registration key. 

4. Select Online 

Registration. Click OK. 

A warning will appear, 

click Yes to continue.  

5. In Stellar Phoenix - 

Electronic Registration 

Wizard, click Next. 

6. Type the serial number 

(received through email 

after purchasing the 

product) in serial number 

field. Click Next. 

7. The software would 

automatically 

communicate with the 

license server. After the 

registration is done, click 

Finish to complete the 

registration process. 
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Note: You can generate PHX_REG.txt file manually via online activation. View Manual Registration to 

perform the process of generating PHX_REG.txt file. 
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Manual Registration 

To register the software manually: 

1. Launch demo version of Stellar Migrator for MS Exchange.    

2. In Registration Menu on Menu Bar, Click Registration.  

3. In Registration Option dialog box, select I have the registration key. 

4. Select Online Registration. Click OK. A warning will appear, click Yes to continue.  

5. In Welcome to Stellar Phoenix - Electronic Software Registration wizard, click Cancel. 

6. Stellar Migrator for MS Exchange dialog box will open, click Yes. 

 

7. In Manual Registration dialog box, enter the serial number that you receive once you purchase 

the software. Click Next. 

 

8. A file named PHX_REG.txt is created on your desktop. Email it to support@stellarinfo.com. Click 

Finished. 

mailto:support@stellarinfo.com
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9. After verifying the purchase details, you will receive the site key, which is required to register the 

software manually. 

10. After receiving the Site Key, open Stellar Migrator for MS Exchange. In Registration Option 

dialog box, select I have the registration key. 

11. Select Manual Registration and Click OK. 

12. Enter the Site Key in Enter Site Key dialog box. Click Validate. 

 

Note: The site key is delivered to the email address through which the serial number is sent.  
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Updating the Software 

Stellar releases periodical software updates for Stellar Migrator for MS Exchange software. You can 

update the software to keep it up-to-date. These updates can add a new functionality, feature, service, or 

any other information that can improve the software. Update option of the application is capable of 

checking for latest updates. This will check for both latest minor and major versions available online. You 

can easily download minor version through the update wizard. However, the major version, if available, 

has to be purchased. While updating the software, it’s recommended to close all the running programs. 

Note that demo version of the software cannot be updated. 

To update Stellar Migrator for MS Exchange: 

 Click Update Wizard icon from Setup menu. 

 Stellar Phoenix Update Wizard window opens. Click Next. The wizard will search for latest 

updates, and if it finds any new updates, a window will pop up indicating its availability. 

 Click Next and the software will download the files from the update server. When the process is 

complete, the software will upgrade to the latest version. 

Live Update may not happen due to following reasons: 

 Internet connection failure 

 Updates are not available 

Note: If a major version is available, you need to purchase the software in order to upgrade it.  
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Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products.  

You can either call us or go online to our support section at http://stellarinfo.com/support/ 

For price details and to place the order, click http://www.stellarinfo.com/email-tools/migrator-for-

exchange/buy-now.php 

Chat Live with an Online technician at http://stellarinfo.com/ 

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

USA (Tollfree- Pre Sales Queries) +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales Support +31-208-111-188 

Worldwide +91-124-432-6777 

Email Orders orders@stellarinfo.com  

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/email-tools/migrator-for-exchange/buy-now.php
http://www.stellarinfo.com/email-tools/migrator-for-exchange/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com
mailto:orders@stellarinfo.com?subject=Purchase%20Order
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 Select Donor 

Select Donor 

 Connect Mailboxes 

 Preview Mailbox Items 
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Connect Mailboxes 

Once Stellar Migrator for MS Exchange establishes a connection with the Donor Exchange server, you 

can preview the mailbox status as connected or disconnected. Stellar Migrator for MS Exchange 

enables you to connect to Donor Exchange server by simply entering login credentials. 

 
To connect mailboxes: 

1. Run Stellar Migrator for MS Exchange.  

2. From the Setup menu, click Select Donor icon to specify the Donor Exchange Server from 

where you want to migrate the mailboxes. 

3. A new window, Donor Exchange Details appears on the screen. Enter Server URL, 

Impersonate User ID, and password.  

4. Select an Impersonate profile from the dropdown list which you have configured on the local 

system. 

 
 

5. Click OK. The application will start connecting to the Donor Exchange Server. 
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6. Once the connection is established, a new window will list name and status (connected / 

disconnected) of all the mailboxes available in the Donor Exchange Server. Click OK. 
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Preview Mailbox Items 

After you make a connection with Donor Exchange server, you can preview a list of mailbox items. 

Preview window is a three pane structure. Left pane shows the connected / disconnected mailboxes and 

folders as a tree structure, Middle pane shows the content of the selected folder as a list. The selected 

mailbox data is displayed in the right pane. 

To preview a mail item 

1. Click on the desired folder from the left pane to preview the detailed data items in the middle 

pane of your screen.  

2. Click the selected data item from middle pane to have a detailed preview displayed in the right 

pane of your screen.  

3. Scroll in the right pane to preview the mail item. 

 
 
Using Stellar Migrator for MS Exchange, you can save individual mail items in either of the given 
formats. 
 
To save mail items individually, simply right-click on it and: 

 Select Save as MSG to save the mailbox in MSG format. 

 Select Save as EML to save the mailbox in EML format. 
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 Select Save as HTML to save the mailbox in HTML format. (Attachments cannot be saved, 

however, their names are visible) 

 Select Save as RTF to save the mailbox in RTF format. (Attachments cannot be saved, however, 

their names are visible)  

 Select Save as PDF to save the mailbox in PDF format. (CC of the mails is not shown and 

attachments cannot be saved, however, their names are visible) 

 

 Right click the desired format in which you want to save your mail items. Click Browse and select 

the Destination Path for saving your file. 

 

 After the execution of the process, you can check your mailbox item by clicking on the link Open 

Containing Folder. 
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Select Recipient 

 Export to PST 

 Export to Recipient Server 
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Export to PST 

Export to PST option of the Donor Exchange Server enables you to export mailboxes to the local 

system.  

To export mailboxes to PST files,  

1. On the Setup menu, click Select Recipient icon. Stellar Migrator for MS Exchange dialog box 

is displayed. 

2. Choose Export to PST option in case you want to export your mailboxes to local system. 

3. Click Browse in case you have selected Export to PST option and provide the location where 

you want to save the mailboxes. Click OK. 

 

4. The application will start exporting mailboxes to the specified location. A window shows the 

processing details of the mailboxes being exported such as Folder name, subject and the number 

of mails exported. 

5. After the execution of the process, you can check your mailbox items by clicking on the Open 

Containing Folder option. Click OK. 
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Note : If you want to export the specific mailboxes, you can select them from the tree node by using the 

checkboxes. 
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Export to Recipient Server 

Export to Recipient option of the Recipient Exchange Server enables you to export your mailboxes to 

another MS Exchange server. 

The configurations are handled on the Local System. To migrate mailboxes, you need an Impersonate 

User on the Donor Exchange along with the Impersonate Profile of Donor and an Administrator Profile of 

Recipient Exchange configured on your local system.  

To export mailboxes to Recipient Server,  

1. From the Setup menu, click Select Recipient icon. Stellar Migrator for MS Exchange dialog 

box is displayed. 

2. Choose Export to Recipient Server option in case you want to export your mailboxes to another 

MS Exchange server. 

3. Select Export to Recipient Server, Click OK. 

 

4. A dialog box, Recipient Exchange Details appears on the screen. 

5. In Recipient Exchange Details dialog box, select the Admin Profile which you configured on the 

local system. 

6. Type a password that is used by the administrator for login. Click OK.  
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7. Once the connection is established, a new window will display all the mailboxes of Donor 

Exchange that you want to move with respective mail ID's of mailboxes. You can also preview 

mailboxes and respective mail ID's of Recipient Exchange server. 

8. To map Mailboxes 

 Click Automap using mailbox names to map mailboxes using names. 

 Click Automap using Email Ids to map mailboxes using associated mail id's. 

 Map mailboxes manually to recipient mailboxes by clicking respective icon under Map Manually 

column. 

 

9. Once you are done with mapping all mailboxes, Click Migrate button to initiate the process of 

moving your mailboxes from Donor Exchange to Recipient Exchange server. 

10. After the migration process is complete, a confirmation message is displayed. Click OK.  
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Note: Ensure that you have created users with the same name or Email ID's for both Recipient and 

Donor Exchange else a "Mismatched" status will be displayed. 
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Import PST file in MS Outlook 

To import PST file in Microsoft Outlook 2010 / 2013:  

1. Open Microsoft Outlook. From File Menu, select Open -> Import. (For MS Outlook 2013, select 

Open and Import from File Menu). 

2. From Import and Export Wizard window, select Import from another program or file, click 

Next. 

3. In Import a File dialog box, select Outlook Data File (.PST), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

5. In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

To import PST file in Microsoft Outlook 2007: 

1. Open Microsoft Outlook. From File menu, select Import and Export. 

2. From Import and Export Wizard window, select Import from another program or file, click 

Next. 

3. In Import a File dialog box, select Personal Folder File (PST), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

5. In Import Personal Folders dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 
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Set Up Impersonation in MS Exchange 2010 

In order to use MS Exchange migration services, you need to create an Impersonate user which can 

either be a new user or one of your existing users. This user account will have impersonation rights for 

the mailbox of each MS Exchange user where impersonate user could access other Exchange users 

mailboxes. 

To set up Impersonation in MS Exchange 2010, follow the steps given below: 

1. Open a Web Browser (Internet Explorer, Firefox, Chrome, etc.) 

2. Navigate to Exchange's OWA Website. 

3. At the login page, enter the Administrator's credentials. Click Sign-in. The main interface which 

appears on the screen is as shown below: 

 

4. Click on Options from the right pane of your screen. 

5. From the right pane of your screen click Manage your organization. 
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6. Click on Administrator Roles tab. Under the role groups section double click on Hygiene 

Management. 
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7. A new window Role Group appears on the screen. 
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8. Under the Members: section click on the +Add button  

9. A new window Select Members appears on the screen. Select the user to which we want to give 

the impersonation rights and click Add -> button. Click OK. 
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10. A window Role Group appears on the screen. Under the Hygiene Management section, click on 

Save button. 
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Set Up Impersonation in MS Exchange 2013 

In order to use MS Exchange migration services, you need to create an Impersonate user which can 

either be a new user or one of your existing users. This user account will have impersonation rights for 

the mailbox of each MS Exchange user where impersonate user could access other Exchange users 

mailboxes. 

To set up Impersonation in MS Exchange 2013, follow the steps given below: 

1. Open the web-based Exchange Admin Center (EAC) for your Exchange 2013 server. The main 

interface is as shown below: 

 

2. From the left pane of your screen click Permissions. 

3. Under the admin roles section, double-click Hygiene Management or click Edit icon above 

the table to assign roles for the impersonation. 
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4. On the Hygiene Management window, Hit the Add icon below the Roles: section. 
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5.  A new window Select a Role appears on the screen. Select ApplicationImpersonation in the 

list under DISPLAY NAME. Click add - > button and then click OK.  
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6. On the Hygiene Management window, Hit the Add icon below the Members: section. 
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7. A new window Select Members appears on the screen. Select the user to which we want to give 

the impersonation rights. 
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8. Select the add - >  button and then click OK. 

8. Click Save. 
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View Log Report 

With Stellar Migrator for MS Exchange, you can save the Log Report to analyze the repairing process 

at a later stage. 

To save the log report: 

 From Logs menu, select Log Report. 

 In Log Report dialog box, click Save Log. 

 

 In Save As dialog box, specify the location where you want to save the log file. Click Save. 
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FAQs 

1. What does the demo version of the software do? 

Demo version of the software is only for evaluation and allows you to preview the Mailbox items 

only. In order to use its full functionality you need to purchase and register the software. 

2. Why do I require to export PST files? 

 There are different scenarios when a user might want to export PST files. 

 If a user wants to take backup of mailbox(es) of ex employee(s) before removing them 

from exchange server then user has to export their mailbox(es) into PST file(s) by using 

Stellar Migrator for MS Exchange.  

 If a user needs to check mailbox of any employee for any reason, he has to first export 

PST file. Then open this PST file in Outlook to read mails. 

 To take backup of selective mailboxes, a user has to export PST files first. These PST files 

can be used as backup. 

3. What is the difference between Donor Exchange server and Recipient Exchange server? 

The server from where you need to migrate the mailboxes is known as Donor Exchange and the 

intended other server where all these mailboxes are exported is known as Recipient Exchange. 

4. How many Impersonate User and Impersonate profile are needed for exporting the 

mailboxes? 

Atleast one Impersonate User is needed on Donor Exchange Server along with Impersonate 

Profile of Donor and Administrator Profile of Recipient Exchange configured on local system. 

5. How to Connect the mailboxes? 

To connect the disconnected mailboxes we need to give Full Access Rights to the users of Donor 

Exchange. 

Command:  Add-MailboxPermission -Identity "Bob" -user "Adam" -AccessRights FullAccess  

Here "Adam" is the Impersonate User who has the Impersonation rights and "Bob" is a user of 

Donor Exchange. 
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6. While trying to activate the software, I’m getting an error message that the software is not 

installed correctly. How can I activate the software? 

 You need to start Crypkey service which is currently stopped. Kindly follow the steps below to 

start Crypkey service. 

     Go to Control Panel. 

     Open Administrative Tools.  

     Then, open Services. 

     Now, right click Crypkey License and click Start. 

     After starting the Crypkey Service, try to activate the software.  
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Legal Notices 

Copyright 

Stellar Migrator for MS Exchange software, accompanied user manual and documentation are 

copyright of Stellar Information Technology Private Limited, with all rights reserved. Under the copyright 

laws, this user manual cannot be reproduced in any form without the prior written permission of Stellar 

Information Technology Private Limited. No Patent Liability is assumed, however, with respect to the use 

of the information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar Migrator for MS Exchange® is a registered trademark of Stellar Information Technology Private 

Limited. 

Windows Server 2008®, Windows Server 2012®, Windows 7®, Windows 8® ,Windows 8.1® ,Windows 

10® are registered trademarks of Microsoft® Corporation Inc. 

Microsoft Outlook 2010® and Microsoft Outlook 2013® is a registered trademark of Microsoft. 

All Trademarks Acknowledged. 
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All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

License Agreement 

Stellar Migrator for MS Exchange  

Copyright © Stellar Information Technology Private Limited INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Migrator for MS Exchange. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Migrator for MS Exchange with which this License is included, you may return 

the complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Migrator for MS Exchange. For purposes of this License, if you have a valid single-user license, 

you have the right to use a single Licensed Copy of Stellar Migrator for MS Exchange. If you or your 

organization has a valid multi-user license, then you or your organization has the right to use up to a 

number of Licensed Copies of Stellar Migrator for MS Exchange equal to the number of copies 

indicated in the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Migrator for MS Exchange may either be used by a single person or 

used non-simultaneously by multiple people who use the software personally installed on a single 

workstation. This is not a concurrent use license. 

All rights of any kind in Stellar Migrator for MS Exchange, which are not expressly granted in this 

license, are entirely and exclusively reserved to and by Stellar Information Technology Private Limited. 

http://www.stellarinfo.com/
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You may not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative 

works based on Stellar Migrator for MS Exchange nor permit anyone else to do so. You may not make 

access to Stellar Migrator for MS Exchange available to others in connection with a service bureau, 

application service provider or similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Stellar Migrator for MS Exchange and all accompanying software, files, data and materials are 

distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You 

acknowledge that good data processing procedure dictates that any program including Stellar Migrator 

for MS Exchange must be thoroughly tested with non-critical data before there is any reliance on it and 

you hereby assume the entire risk of all use of the copies of Stellar Migrator for MS Exchange covered 

by this License. This disclaimer of warranty constitutes an essential part of this License. In addition, in no 

event does Stellar authorize you or anyone else to use Stellar Migrator for MS Exchange in applications 

or systems where its failure to perform can reasonably be expected to result in a significant physical injury 

or in loss of life. Any such use is entirely at your own risk and you agree to hold Stellar harmless from any 

and all claims or losses relating to such unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 
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About Stellar 

Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 

almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

For more information about us, please visit www.stellarinfo.com 

 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/file-eraser.htm
http://www.stellarinfo.com/

